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Preface

This guide provides information about how to install Oracle Health Sciences Clinical 
Development Analytics (OHSCDA).

This preface contains the following topics:

■ Audience on page v

■ Documentation Accessibility on page v

■ Finding Certification Information on page vi

■ Finding Information and Patches on My Oracle Support on page vi

■ Finding Documentation on Oracle Technology Network on page vii

■ Related Documents on page viii

■ Conventions on page ix

Audience
This installation guide is intended for users who are responsible for installing Oracle 
Health Sciences Clinical Development Analytics. You must be familiar with:

■ Oracle Database

■ Oracle Business Intelligence Enterprise Edition (OBIEE) application

■ Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
application

■ Informatica PowerCenter application

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.



vi

Finding Certification Information
Certifications provide access to product certification information for Oracle and third 
party products. A product is certified for support on a specific release of an operating 
system on a particular hardware platform, for example, Oracle Database 10g Release 2 
(10.2.0.1.0) on Sun Solaris 10 (SPARC). To find certification information: 

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Certifications tab. The Certifications page opens and displays the Find 
Certifications region.

3. In Select Product, enter Oracle Health Sciences Clinical Development 
Analytics.

4. Click the Go to Certifications icon.

The right pane displays the certification information.

5. Select a certification to view the certification details.

Finding Information and Patches on My Oracle Support
Your source for the latest information about Oracle Health Sciences Clinical 
Development Analytics is Oracle Support's self-service Web site, My Oracle Support 
(formerly MetaLink). 

Before you install and use an Oracle software release, always visit the My Oracle 
Support Web site for the latest information, including alerts, release notes, 
documentation, and patches.

Creating a My Oracle Support Account
You must register at My Oracle Support to obtain a user name and password account 
before you can enter the Web site.

To register for My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click the Register here link to create a My Oracle Support account. The 
registration page opens. 

3. Follow the instructions on the registration page.

Signing In to My Oracle Support
To sign in to My Oracle Support:

1. Open a Web browser to http://support.oracle.com.

2. Click Sign In.

3. Enter your user name and password.

4. Click Go to open the My Oracle Support home page.

Searching for Knowledge Articles by ID Number or Text String
The fastest way to search for product documentation, release notes, and white papers 
is by the article ID number.

To search by the article ID number:

1. Sign in to My Oracle Support at http://support.oracle.com.
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2. Locate the Search box in the upper right corner of the My Oracle Support page.

3. Click the sources icon to the left of the search box, and then select Article ID from 
the list.

4. Enter the article ID number in the text box.

5. Click the magnifying glass icon to the right of the search box (or press the Enter 
key) to execute your search.

The Knowledge page displays the results of your search. If the article is found, 
click the link to view the abstract, text, attachments, and related products.

In addition to searching by article ID, you can use the following My Oracle Support 
tools to browse and search the knowledge base:

■ Product Focus — On the Knowledge page, you can drill into a product area 
through the Browse Knowledge menu on the left side of the page. In the Browse 
any Product, By Name field, type in part of the product name, and then select the 
product from the list. Alternatively, you can click the arrow icon to view the 
complete list of Oracle products and then select your product. This option lets you 
focus your browsing and searching on a specific product or set of products.

■ Refine Search — Once you have results from a search, use the Refine Search 
options on the right side of the Knowledge page to narrow your search and make 
the results more relevant.

■ Advanced Search — You can specify one or more search criteria, such as source, 
exact phrase, and related product, to find knowledge articles and documentation.

Finding Patches on My Oracle Support
Be sure to check My Oracle Support for the latest patches, if any, for your product. You 
can search for patches by patch ID or number, or by product or family.

To locate and download a patch:

1. Sign in to My Oracle Support at http://support.oracle.com.

2. Click the Patches & Updates tab. 

The Patches & Updates page opens and displays the Patch Search region. You have 
the following options:

■ In the Patch ID or Number is field, enter the primary bug number of the patch 
you want. This option is useful if you already know the patch number.

■ To find a patch by product name, release, and platform, click the Product or 
Family link to enter one or more search criteria.

3. Click Search to execute your query. The Patch Search Results page opens.

4. Click the patch ID number. The system displays details about the patch. In 
addition, you can view the Read Me file before downloading the patch.

5. Click Download. Follow the instructions on the screen to download, save, and 
install the patch files.

Finding Documentation on Oracle Technology Network
The Oracle Technology Network Web site contains links to all Oracle user and 
reference documentation. To find user documentation for Oracle products:

1. Go to the Oracle Technology Network at
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http://www.oracle.com/technetwork/index.html and log in.

2. Mouse over the Support tab, then click the Documentation hyperlink.

Alternatively, go to Oracle Documentation page at

http://www.oracle.com/technology/documentation/index.html

3. Navigate to the product you need and click the link.

For example, scroll down to the Applications section and click Oracle Health 
Sciences Applications.

4. Click the link for the documentation you need.

Related Documents
For more information, see the following documents in the Oracle Business Intelligence 
Data Warehouse Administration Console, Oracle Business Intelligence Enterprise 
Edition Release, Oracle Clinical, Siebel Clinical, and Oracle Health Sciences InForm 
documentation sets.

Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
Documentation
The Oracle Business Intelligence Data Warehouse Administration Console (DAC) 
documentation set includes: 

■ Oracle® Fusion Middleware User's Guide for Oracle Business Intelligence Data 
Warehouse Administration Console 

■ Oracle Business Intelligence Data Warehouse Administration Console Installation, 
Configuration, and Upgrade Guide 

Oracle Business Intelligence Enterprise Edition (OBIEE) Documentation
The Oracle Business Intelligence Suite Enterprise Edition Online Documentation Library 
documentation set includes: 

■ Oracle® Fusion Middleware User's Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Metadata Repository Builder's Guide for Oracle Business 
Intelligence Enterprise Edition 11g Release 1 (11.1.1)

■ Oracle® Fusion Middleware System Administrator's Guide for Oracle Business 
Intelligence Enterprise Edition 11g Release 1 (11.1.1)

■ Oracle® Fusion Middleware Scheduling Jobs Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Security Guide for Oracle Business Intelligence Enterprise 
Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Developer's Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

■ Oracle® Fusion Middleware Integrator's Guide for Oracle Business Intelligence 
Enterprise Edition 11g Release 1 (11.1.1) 

Oracle Clinical Documentation
The Oracle Clinical documentation set includes: 

■ Oracle Clinical Administrator's Guide 
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■ Oracle Clinical Getting Started 

■ Interfacing from Oracle Clinical 

■ Oracle Clinical Conducting a Study 

■ Oracle Clinical Creating a Study 

■ Oracle Clinical Installation Guide 

Siebel Clinical Documentation
The Siebel Clinical documentation set includes: 

■ Siebel Data Model Reference for Industry Applications

■ Siebel Life Sciences Guide

Oracle Health Sciences InForm Documentation
The Oracle Health Sciences InForm documentation set includes:

■ Oracle Health Sciences InForm Upgrade and Migration Guide

■ Oracle Health Sciences InForm Installation Guide

■ Oracle Health Sciences InForm Study and Reporting Setup Guide

■ Oracle Health Sciences InForm User Guide

■ Oracle Health Sciences InForm Reporting and Analysis

■ Oracle Health Sciences InForm Utilities Guide

■ Oracle Health Sciences InForm Clinical Data API Guide

■ Oracle Health Sciences InForm Reporting Database Schema

■ Oracle Health Sciences InForm Secure Configuration Guide

■ Oracle Health Sciences InForm Third Party Licenses and Notices

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Before You Begin

This section presents an overview of the Oracle Health Sciences Clinical Development 
Analytics (OHSCDA) requirements. It also describes the tasks that you must complete 
before you can install the application.

This chapter includes the following sections:

■ Section 1.1, "Technology Stack and System Requirements"

■ Section 1.2, "Installing the Prerequisite Software"

1.1 Technology Stack and System Requirements
The requisite technology stack for OHSCDA configuration consists of the following 
products:

■ Oracle Database 12.1.0.2.0 with patch 19509982

■ Oracle WebLogic Server 10.3.6

■ Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.9.0

■ Oracle Business Intelligence Data Warehouse Administration Console 11.1.1.6.4

■ Informatica PowerCenter 9.5.0 and 9.6.1

Note: Informatica is not part of the media pack. You need to acquire 
its license separately.

All references to media pack server in this document refer to the system 
onto which you download the media pack for Oracle Health Sciences 
Clinical Development Analytics.

Make sure that the domain information of the Informatica repository, 
where you plan to import OHSCDA related Informatica mappings, is 
added to domains.infa file of the Informatica client.
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Installation Considerations
■ Determine the computer on which you will install each component of OHSCDA.

■ You may select to install each product on a different server, if required. The 
OHSCDA media pack server does not have to act as server for any of the products, 
though it may. You may consult Figure 1–1, and the documentation listed in 
Table 1–1 for information on installing each product.

■ Determine the databases you need to create.

■ You must create a database schema to serve as the warehouse for OHSCDA.

■ It is a good practice to create the schema for the OHSCDA warehouse in a new 
database.

■ You may select to create schemas for repositories for the other OHSCDA 
components in the same database that will be used for the OHSCDA warehouse. It 
minimizes the number of databases that you need to maintain for OHSCDA. 
However, if you will be using the component applications for purposes other than 
OHSCDA, Oracle recommends that you create their repositories in instances other 
than the one holding the OHSCDA warehouse.

Table 1–1  System Requirements References

Product Reference

Oracle Database 12.1.0.2.0 with patch 19509982 Database Installation Guide for <platform>

Oracle WebLogic Server 10.3.6 Oracle WebLogic Server Documentation Library

Oracle Business Intelligence Enterprise Edition (OBIEE) 
11.1.1.9.0

System Requirements and Supported Platforms for Oracle Business 
Intelligence Suite Enterprise Edition

Oracle Business Intelligence Infrastructure Installation and Configuration 
Guide

Oracle Business Intelligence Data Warehouse 
Administration Console 11.1.1.6.4

Oracle Business Intelligence Data Warehouse Administration Console 
Installation, Configuration, and Upgrade Guide

Data Warehouse Administration Console User's Guide

Informatica PowerCenter 9.5.0 and 9.6.1 Informatica PowerCenter Installation Guide

Note: It is important to get the technology stack products from the 
OHSCDA media pack because newer versions of the technology stack 
products may have become available but may not be compatible with 
OHSCDA.
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Figure 1–1 Oracle Health Sciences Clinical Development Analytics Technology

For more information about certifications, see Finding Certification Information.

1.1.1 Supported Web Browsers
OHSCDA supports web browsers that are supported by OBIEE. For the list of the 
browsers supported by OBIEE, refer to Oracle Fusion Middleware System Administrator's 
Guide for Oracle Business Intelligence Enterprise Edition 11g.

1.1.2 Source Systems
OHSCDA is designed to extract data from the following three systems:

■ Oracle Clinical (OC) 4.6 or 5.1

■ Siebel Clinical Trial Management System (SC) 8.1.1.15

■ Oracle Health Sciences InForm 4.6, 5.5, 6.0, or 6.1

1.2 Installing the Prerequisite Software
Figure 1–2 displays a sample topology of the technology components for OHSCDA.

Note: For information on Oracle Software Web Browser Support 
Policy, see Doc ID 2092205.1 on My Oracle Support 
(https://support.oracle.com).
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Figure 1–2 Sample Topology

Before you can install the OHSCDA application, you must complete the following 
pre-installation tasks:

■ Install Oracle Database 12.1.0.2.0 with patch 19509982. You can download the 
patch set from My Oracle Support (https://support.oracle.com).

Follow the instructions in Oracle Database Installation Guide for <platform>.

Also, install Oracle Database Client for 12.1.0.2.0 on the system where you are 
running the OHSCDA installer. Follow the instructions in Oracle Database Client 
Installation Guide for <platform>.

■ Install Oracle WebLogic Server 10.3.6

Follow the instructions in Oracle WebLogic Server Documentation Library.

■ Install Oracle Business Intelligence Enterprise Edition (OBIEE) 11.1.1.9.0 with the 
following components:

– Oracle Business Intelligence Server (Supported on Windows and Unix)

– Oracle Business Intelligence Presentation Services (Supported on Windows 
and Unix)

– Oracle Business Intelligence Client Tools (Supported only on Windows)

Follow the instructions in Oracle Business Intelligence Infrastructure Installation and 
Configuration Guide.

■ Install Oracle Business Intelligence Data Warehouse Administration Console 
(DAC) 11.1.1.6.4

Follow the instructions in Oracle Business Intelligence Data Warehouse Administration 
Console Installation, Configuration, and Upgrade Guide.

Note: You must set the init parameter processes for the database to a 
minimum of 500.
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■ Install Informatica PowerCenter 9.5.0 or 9.6.1

Oracle recommends that you create Informatica repository for OHSCDA with the 
following settings:

You must add the AggSupprtWithNoPartLic property in Informatica PowerCenter 
Administration Console, to use the sorted Aggregator transformation set in 
Informatica PowerCenter.

Perform the following steps to add the AggSupprtWithNoPartLic property:

1. Log on to Informatica PowerCenter Administration Console.

2. Select the PowerCenter Integration Service.

3. In Custom Properties, click Edit.

4. Click Add.

5. Enter AggSupprtWithNoPartLic in the Name field.

6. Enter Yes in the Value field.

7. Click OK to add the property.

For more information, see Informatica PowerCenter Installation Guide.

■ If you implement multi-byte character support for OHSCDA, set the following:

– Operating System Level: Ensure that the system that hosts Informatica and 
Database have the following parameters set:

* NLS_LANG=AMERICAN_AMERICA.AL32UTF8

* LANG=en_US.UTF-8

– Database Level: Ensure that the following parameters are set while creating 
database:

* NLS_CHARACTERSET =AL32UTF8

* NLS_NCHAR_CHARACTER= AL16UTF16

– Informatica Level: Oracle recommends that you create Informatica integration 
service for OHSCDA with the following settings:

Table 1–2  Informatica Repository Settings

Settings Value

Character Set UTF8

Versioning True

Global Repository False

Security Audit Trail No

Operating Mode Normal

Table 1–3  Informatica Integration Service

Settings Value

Character Set UTF8

Versioning True

Global Repository False
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■ Informatica Workflow Relational Connection: For all relational connection in 
Informatica (Datawarehouse, Inform_Source, Oracle_Clinical, and Siebel_Clinical), 
set:

– Connection Environment SQL to "alter session set NLS_LENGTH_SEMANTICS 
= 'CHAR';

– Code Page to UTF-8 encoding of Unicode

Security Audit Trail No

Operating Mode Normal

DataMovementMode Unicode

Code Page UTF8

Table 1–3 (Cont.) Informatica Integration Service

Settings Value
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2Installing Oracle Health Sciences Clinical 
Development Analytics

This chapter describes the OHSCDA Installation tasks that you must complete and 
includes the following sections:

■ Section 2.1, "Installing Oracle Health Sciences Clinical Development Analytics"

■ Section 2.2, "Adding InForm Studies to the OHSCDA Warehouse"

■ Section 2.3, "Source-specific Procedures"

2.1 Installing Oracle Health Sciences Clinical Development Analytics 
This section describes the OHSCDA Installation tasks that you must complete.

OHSCDA application installation consists of the following components:

■ Running the OHSCDA Installer

■ Setting Up Relational Connections in the Informatica Workflow for OHSCDA

■ Preparing a DAC Repository for OHSCDA

■ Emplacing the OHSCDA Help and Image Files

■ Preparing the OBIEE Web Catalog and Repository for OHSCDA

2.1.1 Running the OHSCDA Installer
The basic OHSCDA components are installed using the Oracle Universal Installer. The 
installer gathers all the information about the database connectivity, data mart, 
Informatica repository by presenting a sequence of prompt screens and then installs 
the components accordingly.

Note: 

■ All references to ${DAC_INSTALL_DIR} in this document refer to 
DAC installation folder.

Important: Make sure that both the Oracle Database client and the 
Informatica client are available on the same system where you plan to 
execute the installer.
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Perform the following steps to install the OHSCDA application on Windows:

1. Extract the contents of the media pack into a temporary directory (For example, 
C:\ocda_temp).

2. Navigate to the \install directory under the extracted temporary folder.

3. Double-click the setup.exe file to launch the Oracle Universal Installer with the 
Welcome screen.

The installer will take you through a series of screens having fields. Attend to the 
Installer’s prompts. The following sections describe each Installer screen, and the 
required action.

The Welcome screen provides information about the Oracle Universal Installer. 
The following function buttons appear on the installation screens:

■ Deinstall Products: Deinstall individual components or the entire product. 
This button appears only on the Welcome screen.

■ About Oracle Universal Installer: View the version number of the installer in 
use.

■ Help: Access detailed information about the functionality of each screen.

■ Installed Products: View currently installed products or deinstall the entire 
product or components.

■ Next: Proceed to the next screen.

■ Cancel: Cancel the installation process and exit the installer.

4. Click Next.

The Specify Home Details screen appears.

5. Enter the name of the installation and path where all the staged files from the 
Installer get copied to the local system. This is also the location from where 
Installer executes the database script.

Example Name: OCDAHome1

Path: C:\OCDA

6. Click Next.

The Install or Upgrade OHSCDA screen appears.

7. Select one of the following options:

■ Install: If you want to make a fresh installation of OHSCDA.

■ Upgrade: If you want to upgrade an existing OHSCDA 3.0 instance.

8. Click Next.

The OHSCDA Data Warehouse Details screen appears.

This screen collects all the information regarding the OHSCDA data warehouse.

9. Enter values in the following fields:

■ Data Warehouse Connect String: Connection of the database where OHSCDA 
Data Warehouse will be deployed.

Note: Make sure the connect string matches the value in the 
tnsnames.ora file.



Installing Oracle Health Sciences Clinical Development Analytics

Installing Oracle Health Sciences Clinical Development Analytics 2-3

■ Database Host Name

■ Database Port No

■ Database Service Name

■ Default Tablespace Name

■ Temporary Tablespace Name

10. Click Next.

The OHSCDA Data Warehouse screen appears.

11. Enter and confirm the system password of the database where OHSCDA Data 
Warehouse will be deployed.

12. Click Next.

The OHSCDA Data Warehouse Details screen appears.

13. Enter and confirm the OHSCDA Warehouse schema (RXI) password.

14. Click Next.

15. Enter and confirm the OHSCDA RPD (RXI_RPD) password.

The OHSCDA Informatica PowerCenter Details screen appears.

This screen collects all information to connect to the Informatica server.

16. Enter values in the following fields:

■ Informatica Repository Name: Informatica Repository Name where you plan 
to import OHSCDA Informatica mappings.

■ Informatica Domain Name: Domain of the Informatica repository.

■ Informatica Hostname: Host name of the Informatica server.

■ Informatica Repository Port Number: Port number of the Informatica server.

■ Informatica Username with Admin Privileges: User with Admin privilege to 
import XMLs.

17. Click Next.

The OHSCDA Informatica Details screen appears.

18. Enter and confirm the Informatica password for admin user.

19. Click Next.

The OHSCDA Informatica PowerCenter Client Home Directory screen appears.

20. Enter the Informatica PowerCenter client home path.

For example,

Informatica PowerCenter client home: D:\Informatica\9.5.0\clients\PowerCenter 
client\client

21. Click Next.

The National Language Support screen appears.

22. Select one the following options:

■ Yes: If the source data contains data in English and any other language.

■ No: If the source data contains data only in English.
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23. Click Next.

The Summary screen appears.

24. Verify the details provided in the Summary screen.

25. Click Install.

2.1.2 Setting Up Relational Connections in the Informatica Workflow for OHSCDA 
For each database that will be a source for extracting data into the OHSCDA 
warehouse, perform the following steps to create a Relational Connection in the 
Informatica Workflow Manager:

1. Launch the Informatica PowerCenter Workflow Manager.

2. Connect to the repository where OHSCDA Informatica mappings are imported.

3. Select Connections, and then select Relational to display the Relational 
Connection Browser.

4. Click New to display the Select Subtype dialog.

5. Select Oracle as database type, and then click OK. The Connection Object 
Definition dialog box is displayed with options for the selected database platform.

6. Enter values in the following fields according to the Source database connection:

■ Connection Name: Enter the logical connection name.

■ User Name: Enter the user name that can access source data (For example, 
rxa_des for Oracle Clinical.)

■ Password: Enter the database password.

■ Connection String: Enter the Connect string for connecting to the database.

■ Code Page: Enter UTF-8 encoding of Unicode.

2.1.3 Preparing a DAC Repository for OHSCDA
You will be using CDA_Warehouse.zip file in this section.

1. Create a new DAC repository, as an Administrator.

2. Unzip OCDA_HOME\oracle.pharma.ocda.standard\DAC_Code\CDA_
Warehouse.zip onto the computer where you will run DAC client.

3. Import the OHSCDA Warehouse Application metadata.

Note: You must record the log file path that appears on the bottom of 
the screen for future reference.

Note: These values will also be required in setting up DAC. Make 
note of them to ensure that you enter the same during DAC setup.

The TNS entry for all your source and target databases must be added 
on Informatica Server.

Note: You must repeat steps 1 through 4 for each required source 
connection.
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a. Start the Data Warehouse Administration Console (DAC) client.

b. From the Tools menu select DAC Repository Management, and then select 
Import.

c. Click Change import/export folder to navigate to the folder where you 
unzipped CDA_Warehouse.zip in step 2 of Section 2.1.3, "Preparing a DAC 
Repository for OHSCDA".

d. Click OK to display the Import dialog box.

e. Select the following categories of metadata you want to import: Logical, 
Overwrite log file, and User Data. Deselect the System check box.

f. Select CDA_Warehouse application in the ApplicationList.

g. Click OK.

h. Enter the verification code and Yes in the secondary window that is displayed 
after the import.

i. You can inspect the import log in ${DAC_ INSTALL_DIR}\log\import.log to 
verify if import is successful.

4. Configure Informatica Repository Service in DAC.

a. Navigate to the Setup view, and then select the Informatica Servers tab.

b. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

c. Enter values in the following fields:

Name: Enter the Logical name for the Informatica server (for example, INFA_
REP_SERVER).

Type: Select Repository.

Hostname: Enter the host system name where Informatica Server is installed.

Server Port: Enter the port number Informatica Server or Informatica 
Repository Server use to listen to requests.

Login: Enter the Informatica user login for the Admin user.

Password: Enter the Informatica Repository password.

Repository Name: Enter the Informatica Repository Name.

d. Test the connection to verify the settings.

e. Click Save to save the details.

5. Configure Informatica Integration Service in DAC.

a. Click New to display the Edit tab below or select an existing Informatica 
server from the list.

Note: Make sure that you use the same Login and Password that you 
have used in setting up Informatica.
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If you are configuring a new installation, the Informatica Servers tab will be 
empty. If you are upgrading an existing installation, the Informatica Servers 
tab might contain existing Informatica servers.

b. Enter values in the following fields:

Name: Enter the Logical name for the Informatica server (for example, INFA_
SERVER).

Type: Select Informatica.

Service: Informatica Integration Service Name associated with the Informatica 
repository added in Step 5.

Domain: Enter the Informatica domain name.

Login: Enter the Informatica Repository user login (Admin User).

Password: Enter the Informatica Repository password.

Repository Name: Enter the Informatica Repository Name.

c. Test the connection to verify the settings.

d. Click Save to save the details.

6. Configure source databases (Oracle Clinical, Siebel Clinical, and InForm) and the 
target database (the OHSCDA warehouse). For each database with which DAC 
will interact for OHSCDA, perform the following steps:

a. Navigate to the Setup view, and then select the Physical Data Sources tab.

b. Click New to display the Edit tab below or select an existing database 
connection from the list.

c. Enter values in the following fields:

- Name: Enter the Logical name for the database connection.

- Type: Select Source when you create the database connection for a 
transactional (OLTP) database. Select Warehouse when you create the database 
connection for a data warehouse (OLAP) database.

- Connection Type: Select a connection type for the database connection.

- Instance or TNS Name: Enter the Data Mart database instance name.

- Table Owner: Enter the Data Mart schema name. 

- Table Owner Password: Enter the Data Mart schema password.

- DB Host: Enter the Data Mart host name.

- Port: Enter the Data Mart host port.

- Dependency Priority: Enter the user-defined priority of the data source.

- Data Source Number: Enter the user-defined number of the data source.

- Num Parallel Indexes Per Table: Enter a number to specify how many 
indexes are to be created in parallel. 

d. Test the connection to verify the settings.

e. Click Save to save the details.
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7. Perform the following steps to modify the value for data sources:

a. Navigate to the Execute view, and then select the Execution Plans tab.

b. If Oracle Clinical, Siebel Clinical, and InForm are your source systems, select 
CDA - Complete Warehouse from the list.

If Oracle Clinical is your only source system, select CDA - Oracle Clinical 
Warehouse from the list. 

If Siebel Clinical is your only source system, select CDA - Siebel Clinical 
Warehouse from the list. 

If InForm is your only source system, select CDA - InForm Warehouse from 
the list. 

c. Click Parameters subtab in the bottom pane.

Note: By Default, Oracle supports Data Source Number 1, 2, and 3 
for Oracle Clinical, Siebel Clinical, and InForm respectively.

The logical Names of the connections in DAC must be same as the 
connection names created in Informatica Workflow Manager.

OHSCDA Warehouse connection must be the same as provided 
during OHSCDA installation.

Table 2–1  Sample of Data Source Table W_RXI_DATASOURCE_S

ROW_
WID

DATASOURCE
_NUM_ID

DATASOURCE_
NAME

DELETE_
FLG INTEGRATION_ID

ENTERPRISE
_ID INFORM_STUDY_GUID 

1 1 ORACLE_
CLINICAL

N ORACLE_
CLINICAL

0 -

2 2 SIEBEL_
CLINICAL

N SIEBEL_CLINICAL 0 -

3 3 INFORM N INFORM 0 {FA5BCD87-B858-4F08-8BF
8-1914B61C9DDF}

4 101 INFORM_1 N INFORM_1 0 {CC0DBD73-FA40-4943-BD
B3-60752C1A2732}

Note: If InForm is one of your sources and auto merge feature is not 
used, then the column INFORM_STUDY_GUID must be populated 
with studyguid for the corresponding InForm study.

You can find the distinct studyguid from table RXI_STUDYVERSIONS 
in the consolidation database.

From DAC, the value passed for the data source parameter is always 
3. Since we have one consolidation DB which holds all study data, the 
guid, when auto merge is set to N, helps resolving individual data 
source numbers.

If auto merge is set to Y, then a single entry for data source 3 for 
INFORM is sufficient and INFORM_STUDY_GUID need not be 
populated. In this case, the consolidation DB is considered as single 
source and duplicates are handled by auto merge.
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d. For each row with TYPE equal to DATASOURCE, in the Value field, select the 
appropriate Physical Data Source Name from the drop-down list for the field.

e. Select a relevant value from the list for each of the data sources.

f. Click Save.

2.1.3.1 DAC Configurable Parameters
Navigate to each of the containers and make sure that values are set for each of the 
available parameter.

Table 2–2 lists the DAC configurable parameters.

Note: ■If Oracle Clinical, Siebel Clinical, and InForm are your source 
systems, use CDA - Complete Warehouse.

■ If Oracle Clinical is your only source system, use CDA - Oracle 
Clinical Warehouse.

■ If Siebel Clinical is your only source system, use CDA - Siebel 
Clinical Warehouse.

■ If InForm is your only source system, use CDA - InForm 
Warehouse.

Table 2–2  DAC Configurable Parameters

Parameter Description

START_TS This is the last refresh time of the source tables minus prune 
days. (@DAC_SOURCE_PRUNED_REFRESH_
TIMESTAMP)

END_TS Current Execution Plan’s actual start time adjusted to source 
database time zone minus prune days. (@DAC_ETL_
START_TIME_FOR_SOURCE)

DATASOURCE_NUM_ID The ID associated with every source system. The default ID 
is 1 for Oracle Clinical, 2 for Siebel Clinical, and 3 for 
InForm.

ENTERPRISE_ID The ID associated for every tenant. The default value is 0.

DELETE_FLOW The default value is N and set it to Y if Deletes have to be 
captured in the data warehouse.

EMAIL_SUFFIX You can provide domain name as a suffix to username. For 
example: oracle.com

Prune Days This is used for setting the END_TS for incremental load.

MPI_AUTHFILE Currently, not in use.

MPI_USER Currently, not in use.

AUTO_MERGE_FLG This is used to enable or disable auto-merge.

■ Y: Enables auto-merge

■ N: Disables auto-merge

$OutputFile_OCDA Currently, not in use.

$DBConnection_SP_OLAP Currently, not in use.

$DBConnection_OLAP Currently, not in use.
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2.1.4 Emplacing the OHSCDA Help and Image Files 
You will be using help.zip and images.zip files in this section.

2.1.4.1 Placement of Files for Oracle WebLogic Managed Server
You need to manually deploy OHSCDA’s help and images files on Oracle WebLogic 
Managed Server. Perform the following steps:

1. Navigate to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\ in Oracle WebLogic Server.

2. Create the following folders at <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\

■ s_ocda

3. Unzip help.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Help to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\

4. Move customMessages and sk_ocda folders from <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda\help\ to 
<MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\.

5. Add the following tag in instanceconfig.xml, present in <MIDDLEWARE_
HOME>\instances\instance1\config\OracleBIPresentationServicesComponent\c
oreapplication_obips1:

<UI><DefaultSkin>ocda</DefaultSkin> 
<DefaultStyle>ocda</DefaultStyle></UI>

6. Unzip the Images.zip files from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Images to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\s_ocda

7. Launch Oracle WebLogic Administration Server Console.

Example: https://hostname.domain:port/console

This opens the Oracle WebLogic Server Administration Console.

8. Log on to Oracle WebLogic Server Administration Console as an Administrator.

9. In the left pane of the Administration Console, select Deployments.

10. On the left pane, click Lock & Edit.

11. In the right pane, click Install.

This opens the Install Application Assistant.

12. In the Path field browse to <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\.

13. Select analyticsRes and click Next.

14. Select Install this deployment as an application and click Next.
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15. In Available targets for analytics, select the servers in the cluster on which you 
want to deploy OHSCDA.

16. Click Next.

17. In the Deployment targets, select bi_server1.

18. Click Next.

19. Select I will make the deployment accessible from the following location option 
for <MIDDLEWARE_
HOME>\instances\<instancename>\bifoundation\OracleBIPresentationServices
Component\coreapplication_obips1\analyticsRes\ in the Source accessibility 
section.

20. Click Finish.

analyticsRes appears in the Deployment section.

21. Click Activate Changes.

22. Select analyticsRes in the Deployment section.

23. Click Start to view the list and select Servicing all requests. The Start Application 
Assistant page is displayed.

24. In the content pane of the new page, click Yes to start the selected deployment.

State of analyticsRes should be Active after this deployment. You may confirm the 
same on Deployments page. 

25. Log out from Oracle WebLogic Server Administration Console.

26. Log on to Oracle Enterprise Manager Fusion Middleware Control.

27. Restart the BI components.

28. Log on to OBIEE and verify the branding and help links on the dashboards.

See Also:

■ Oracle WebLogic Server Documentation Library

2.1.5 Preparing the OBIEE Web Catalog and Repository for OHSCDA
You will be using OCDA.zip and OCDA.rpd files in this section.

1. To deploy InForm web catalog, copy OCDA.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Webcat\Inform_Webcat to 
OBIEE server.

Else, copy OCDA.zip from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\Webcat to OBIEE server.

2. Copy OCDA.rpd files from OCDA_
Home\oracle.pharma.ocda.standard\Reporting\RPD to OBIEE server.

3. Unzip OCDA.zip in the following folder: 

■ Windows32 - <DRIVE>:\<MIDDLEWARE_
HOME>\instances\instance1\bifoundation\OracleBIPresentationServicesCo
mponent\coreapplication_obips1\catalog

■ UNIX - /<MIDDLEWARE_
HOME>/instances/instance1/bifoundation/OracleBIPresentationServicesCo
mponent/coreapplication_obips1/catalog
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4. For fresh installation, create a TNS entry of OHSCDA database in %ORACLE_
BI%\network\admin. 

5. Create an ODBC entry (System DSN) to connect to (RXI) using Oracle Database 
11g client driver.

6. In the Oracle BI Administration Tool, select File, then Open, and then Offline.

7. Navigate to the OCDA.rpd, and then click Open.

Password: Admin123

8. Click OK.

9. In the Oracle BI Administration Tool, select File, then Change Password.

10. Enter the current (old) password.

11. Enter the new password and confirm it. 

12. Confirm the new password.

13. Click OK.

14. Modify the connection pools in the RPD as following:

a. In the physical layer, expand the OHSCDA Data Warehouse node and 
double-click Connection Pool object to open Connection Pool dialog box. 

b. Set Data source name field to the ODBC entry for the warehouse you created 
in step 3.

c. Change the username to the username of the OHSCDA read-only schema. 
(RXI_RPD)

d. Change the password to the password of the OHSCDA read-only schema. 
(RXI_RPD)

e. Click OK.

f. Reconfirm the password. 

g. Click OK.

15. From the File menu, select Save to save the rpd. 

16. Click Yes for Do you wish to check global consistency?

17. Click Close in the Consistency Check Manager.

18. Click Save.

19. Click File and then click Close.

20. Click File and then click Exit.

21. Open NQSConfig.xml found at <MIDDLEWARE_
HOME>instances\instance1\config\OracleBIServerComponent\coreapplication_
obis1.

22. Set EVALUATE_SUPPORT_LEVEL =2. 

23. Start the Oracle WebLogic Server and BI components.

24. Open the Fusion Middleware Control URL from the system where you saved the 
OCDA.rpd in step 13. The URL includes the name of the host and the port number 
assigned during the installation. The following shows the format of the URL:

https://hostname.domain:port/em
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The login page is displayed.

25. Enter the Oracle Fusion Middleware administrator user name and password and 
click Login.

26. Expand the Business Intelligence folder and select the coreapplication node.

The Overview page displays the current status of the system, by providing 
information about current availability, performance, and issues identified within 
the BI domain. The Overview page also enables you to start and stop Oracle 
Business Intelligence.

27. Navigate the Repository tab of the Deployment page.

28. Click Lock and Edit Configuration.

29. Click Close.

30. In the Upload BI Server Repository section, click Browse and navigate to select the 
RPD.

31. Enter the RPD password in Repository Password and Confirm Password fields.

32. In the BI Presentation Catalog section, enter <ORACLE_
INSTANCE>/bifoundation/OracleBIPresentationServicesComponent/<COMPO
NENT_NAME>/catalog/OCDA in the Catalog Location field.

33. Click Apply, and then click Activate Changes.

34. Return to the Business Intelligence Overview page and click Restart.

2.1.6 Configuring Maps
To configure maps:

1. Go to 
http://www.oracle.com/technetwork/middleware/bi-foundation/obieesamples
archive-2026956.html.

2. Navigate to OBIEE 11.1.1.3 - Sample Application.

3. Click Documentation Downloads.

4. Click Save.

5. Unzip the folder.

6. Open SampleApp_Deploy_Instructions_825.pdf.

7. For instructions on how to configure maps, see section 6 Deploying SampleApp 
Mapviewer Content.

2.1.7 Creating Security Groups and Application Roles for OHSCDA

2.1.7.1 Creating Groups
Perform the following steps to create groups:

Note: Oracle recommends that you enable HTTPS on middle-tier 
computers that are hosting the Web services, since otherwise the 
trusted user name and password that are passed can be intercepted.
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1. Launch Oracle WebLogic Server Administration Console.

2. In Oracle WebLogic Server Administration Console, select Security Realms from 
the left pane and click the realm you are configuring. For example, myrealm.

3. Select Users and Groups tab, then Groups.

4. Click New.

5. In the Create a New Group page provide the following information:

■ Name: Enter the name of the group. Group names are case insensitive but 
must be unique. See online help for a list of invalid characters.

■ (Optional) Description: Enter a description.

■ Provider: Select the authentication provider from the list that corresponds to 
the identity store where the group information is contained. 
DefaultAuthenticator is the name for the default authentication provider.

6. Click OK.

The group name is added to the Group table.

7. Repeat step 4 through 6 with the following values:

2.1.7.2 Creating Application Roles
Perform the following steps to create groups:

1. Log on to Oracle Enterprise Manager Fusion Middleware Control.

2. From the target navigation pane, open Business Intelligence and select 
coreapplication.

3. Right-click coreapplication, then select Security to display a submenu with 
Application Policies and Application Roles as options.

4. Select Application Roles. The Application Roles page is displayed.

5. Click Create to display the Create Application Role page. Complete the fields as 
follows:

In the General section:

■ Role Name - Enter the name of the Application Role.

■ (Optional) Display Name - Enter the display name for the Application Role.

■ (Optional) Description - Enter a description for the Application Role.

6. In the Members section, select Add Group. To search in the dialog box that 
displays:

a. Click the blue button to search. It will display a list of all the groups.

Table 2–3  Security Group Parameters

Name Description Provider

OCDA-CRA (Optional) DefaultAuthenticator

OCDA-DataManager (Optional) DefaultAuthenticator

OCDA-ExecutiveManager (Optional) DefaultAuthenticator

OCDA-RegionManager (Optional) DefaultAuthenticator

OCDA-StudyManager (Optional) DefaultAuthenticator

OCDA-WebcatAdim (Optional) DefaultAuthenticator
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b. Select from the results returned in the Available box.

c. Use the shuttle controls to move the desired name to the Selected box.

d. Click OK to return to the Create Application Role page.

e. Repeat steps 5 and 6 for all the Roles listed in the following table: 

2.2 Adding InForm Studies to the OHSCDA Warehouse

2.2.1 OHSCDA InForm Consolidation Schema
This section describes how OHSCDA extracts InForm's operational data and loads it 
into the OHSCDA warehouse. All of the data for each InForm study is maintained in a 
transactional database (actually a database schema). InForm maintains one or more 
InForm databases per Oracle database instance. Each study also has a Reporting and 
Analysis database (again, a set of objects in a schema, not necessarily an exclusive 
database instance) which contains data in views designed for query, as opposed to 
transactional activity.

Inform maintains the Reporting and Analysis database for each study in a 
study-specific schema. For efficiency and maintainability, OHSCDA has created a 
program that extracts data from a number of InForm Reporting and Analysis 
databases and places that data into a single consolidated database. Then, OHSCDA's 
source-dependent extract code reads from the consolidated database, and writes to the 
OHSCDA warehouse.

For the remainder of this section, refer to any given InForm Reporting and Analysis 
database as a source schema and the schema in which OHSCDA consolidates InForm 
data as the consolidation schema.

OHSCDA consolidates data from selected InForm source schema views, the selected 
ones being the ones that have data corresponding to columns in the OHSCDA data 
model. The following are the InForm source views that are consolidated for OHSCDA:

■ IRV_AF_SUBJECT_FORMS

■ IRV_CUR_QUERY

■ IRV_CUR_RULE

■ IRV_CUR_SITE

■ IRV_CUR_SPONSOR

■ IRV_CUR_SUBJECT

■ IRV_CUR_USER

Table 2–4  Application Roles and Groups

Role Name Description Groups

OCDA-CRA (Optional) OCDA-CRA

OCDA-DataManager (Optional) OCDA-DataManager

OCDA-ExecutiveManager (Optional) OCDA-ExecutiveManager

OCDA-RegionManager (Optional) OCDA-RegionManager

OCDA-StudyManager (Optional) OCDA-StudyManager

OCDA-WebcatAdim (Optional) OCDA-WebcatAdim
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■ IRV_FORM_REVS

■ IRV_ITEMSET_REVS

■ IRV_ITEM_REVS

■ IRV_QUERY_STATE_CHANGES

■ IRV_SECTION_REVS

■ IRV_STUDYVERSIONS

■ IRV_STUDYVERSION_FORMS

■ IRV_STUDYVERSION_VISITS

■ IRV_SUBJECT_STATE_CHANGES

■ IRV_SV_SUBJECTVISITS

■ IRV_USERS_SITES

For each of these source views, the consolidation schema contains a consolidation 
table. Each consolidation table has the same columns as its source view, except that the 
consolidation table has three additional columns:

■ STUDYGUID

■ CONSOLIDATION_DATETIME

■ MODIFIEDDATETIME

STUDYGUID is needed to retain the association of each record with its InForm study. 
CONSOLIDATION_DATETIME and MODIFIEDDATETIME allows OHSCDA ETL to 
detect which consolidated records have been added or updated since the prior ETL 
execution.

The names of tables in the consolidation schema match the names of their source 
views, with the following change:

■ IRV in the source view name is replaced with RXI in the consolidation table name.

Consolidation is the process of getting new or modified records from a source schema 
and updating the consolidation schema with those records. Consolidation is carried 
out by periodic execution of a scheduled job in each InForm schema that contributes to 
the consolidation schema. Execution is done through the DBMS_JOB facility. Each 
source schema is consolidated on its own schedule.

There is no master job that oversees or coordinates the consolidation of all the source 
InForm schemas. You can choose to consolidate different InForm schemas at different 
times, and with different intervals between consolidations. However, the more spread 
out consolidations are, the wider the time period represented by the records in the 
consolidation schema. So it is recommended that you schedule consolidation jobs to 
fall within a small time window. For details on scheduling, see Section 2.2.7, 
"Adjusting Scheduling of Consolidation Jobs".

When the Consolidation job executes for a particular source schema, it does the 
following:

For each source table from which OHSCDA extracts data,

■ Identify what records have been created or modified in this table since the 
previous consolidation

■ For each modified source record, drop the corresponding record in the 
consolidation table
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■ Insert all new and modified records in the Consolidation schema table, setting 
their StudyGUID, and modification timestamps

The procedures that does this work reside in each InForm Reporting and Analysis 
Schema, they are placed there as part of the process of preparing that schema for 
consolidation.

Preparation for consolidation also creates an access account in the database holding 
the source schema. This account is the one that reads the Reporting views, and writes 
to the consolidation tables. This access account is named CDAxxx, where xxx is the 
Study name.

All movement of data is done by a pull from the Reporting and Analysis Database to 
the Consolidation database. This ensures that there is no path by which someone who 
can connect to the consolidation schema is able to modify the InForm database.

The instructions that follow tell how to do the initial setup of the consolidation schema 
(this also enrolls the first Study to be consolidated as part of the process) and then how 
to set up each additional InForm study so that it becomes a contributor to the 
Consolidation schema.

2.2.2 Prerequisites
Before you begin:

1. Navigate to OCDA_HOME\oracle.pharma.ocda.standard\OCDA_Common_
Scripts\Inform_Consolidate.zip.

2. Copy and unzip the InForm_consolidate.zip file to a server from which it is 
possible to access all InForm source database that contain studies that are to be 
consolidated and also to access the database in which the consolidation schema is 
located.

2.2.3 Setting up Consolidation Schema
This section describes the steps to create the Consolidation Schema. As part of the 
process, it enrolls an initial InForm study as a source to be consolidated.

2.2.3.1 Preparing TNSNAMES Files on Source and Target Database Servers
If one does not already exist, create a TNSNAMES.ORA entry for the Consolidation 
database instance on each InForm database server that contains a study that is to be 
consolidated. 

■ On the consolidation schema database server, add a TNSNAMES.ORA entry for 
each source schema database. 

2.2.3.2 Creating a Consolidation Management Root Directory
■ On consolidation schema database server, create a root directory for managing the 

files needed to configure and log consolidation of the source schemas.

We will refer to this directory as <$ConsolidationMgmtRoot>.

Note: This is not essential. If you prefer not to create the 
TNSNAMES entries, you can provide the complete connection string 
instead of the TNS name when specifying remote databases below.
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If trial source and target consolidation DB are in the same network, then a single 
<$ConsolidationMgmtRoot> is sufficient. Else, replicate the directory in both the 
servers.

During the setup of the source trial DB, use TrialCDA and logs folders. And, during 
the setup of the destination consolidation DB, use DestCDA and logs folder.

2.2.4 Initiating Consolidation of InForm Studies
This section describes the steps you must follow to prepare a source schema for 
consolidation and perform the initial execution of consolidation of that schema. 
Subsequent consolidations occurs automatically at an interval you define as part of the 
preparation described here.

The setup and configuration is performed in the following two phases for each study 
trial:

■ Section 2.2.4.1, "Source Trial Database Configuration"

■ Section 2.2.4.2, "Destination Consolidation Database Configuration"

2.2.4.1 Source Trial Database Configuration
Follow the instructions in this section for each InForm study that is to be consolidated 
for consumption by OHSCDA.

1. On either source or consolidation schema database server, based on the network 
architecture as described in Section 2.2.3.2, create a directory within 
<$ConsolidationMgmtRoot> /<Study-name> to hold the files for consolidation of 
this study.

2. Copy the contents of InForm_consolidate.zip into the 
<$ConsolidationMgmtRoot>/<Study-name>/TrialCDA directory.

3. Set your current directory to the <$ConsolidationMgmtRoot>/<Study-name> 
directory.

4. Edit CONFIGTRIALCDA.sql to set specific values of configuration parameters for 
this study. Make the following changes:

Table 2–5  Source Trial Configuration Parameters

Parameter Set value to

Slash Use \ for Windows or / for Linux

trial_name The name of the study.

inform_release For InForm 4.6, enter R46. For later releases, enter 
R55.

trial_tnsname Name in the local TNSNAMES file of the source 
database for the study. Can also supply entire TNS 
entry for the source database as a string.

trial_schema_user Username of the InForm source schema.

trial_schema_password Password of the InForm source schema.

trial_ro_user This is OHSCDA reporting object schema user name 
and is defaulted to trail_name prefixed with 'cda'.

trial_ro_password This is OHSCDA reporting object schema password 
and is defaulted to trail_name prefixed with 'cda'. 
You can change this password.
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5. Save the file.

6. Connect to SQLPlus. Execute the following command:

sqlplus /nolog
7. From the command prompt, execute the following command:

@Setup_Trial_CDA.sql
8. Navigate to the <$ConsolidationMgmtRoot>/<Study-name>/Logs directory to 

review the log.

If any errors are found, make necessary corrections and re-execute Setup_Trial_
CDA.sql.

2.2.4.2 Destination Consolidation Database Configuration
Follow the instructions in this section for each InForm study that is to be consolidated 
for consumption by OHSCDA.

1. On the consolidation schema database server, based on the network architecture as 
described in Section 2.2.3.2, "Creating a Consolidation Management Root 
Directory", create or reuse a directory within <$ConsolidationMgmtRoot> 
/<Study-name> to hold the files for consolidation of this study.

2. Copy or reuse the contents of InForm_consolidate.zip into the 
<$ConsolidationMgmtRoot>/<Study-name> directory.

3. Set your current directory to the 
<$ConsolidationMgmtRoot>/<Study-name>/DestCDA directory.

4. Edit CONFIGDESTCDA.sql to set specific values of configuration parameters for 
this study. Make the following changes:

The trial parameters mentioned in Table 2–6 must match with the ones defined in 
Table 2–5.

trial_dba_user Database username who has the dba privileges.

trial_dba_password Password for database username.

trial_ts Name of a tablespace in the source schema database 
to which the access account for this study will be 
given access.

trial_ts_temp Name of a temporary tablespace in the source 
schema database to which the access account for this 
study will be given access.

Note: If you prefer not to create the TNSNAMES entries, you can 
provide the complete connection string instead of the TNS name when 
specifying the remote databases below.

Table 2–6  Destination Configuration Parameters

Parameter Set value to

Slash Use \ for Windows or / for Linux

Parameters for configuring the source schema and database

Table 2–5 (Cont.) Source Trial Configuration Parameters

Parameter Set value to
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5. Save the file.

6. Connect to SQLPlus. Execute the following command:

sqlplus /nolog
7. From the command prompt, execute the following command:

trial_name The name of the study.

inform_release For InForm 4.6, enter R46. For later releases, enter 
R55.

trial_tnsname Name in the local TNSNAMES file of the source 
database for the study. Can also supply entire TNS 
entry for the source database as a string.

trial_schema_user Username of the InForm source schema.

trial_global_name Global name of the source schema database. You can 
get this by connecting to the source schema and 
running the following query:

SELECT * FROM GLOBAL_NAME

trial_ro_user This is OHSCDA reporting object schema user name 
and is defaulted to trail_name prefixed with 'cda'.

trial_ro_password This is OHSCDA reporting object schema password 
and is defaulted to trail_name prefixed with 'cda'. 
You can change this password.

Parameters for configuring the target schema and database

dest_tnsname Name of the target database in the TNSNAMES file 
on the source database server for the study. Can also 
supply entire TNS entry for the target database as a 
string.

dest_schema_owner This defaults to and is same as trial_ro_user 
parameter.

dest_schema_password This defaults to and is same trial_ro_password 
parameter.

dest_consolidated_user This is the consolidation schema username. Default is 
RXI_INFORM.

dest_consolidated_password This is the consolidation schema password. Defaults 
is RXI_INFORM. You can change this password.

dest_dba_user Database username who has dba privileges on the 
consolidation database.

dest_dba_password Password for the database username on the 
consolidation database.

dest_ts Name of a tablespace in the target schema database 
to which the consolidation and access account will be 
given access.

dest_ts_temp Name of a temporary tablespace in the target schema 
database to which the consolidation and access 
account will be given access.

consolidate_job_interval The interval between executions of the program to 
consolidate new and modified data from this study. 
A value of 1 results in an interval of one day. A value 
of 1/24 results in an interval of one hour.

Table 2–6 (Cont.) Destination Configuration Parameters

Parameter Set value to
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@Setup_Dest_CDA.sql
8. Navigate to the <$ConsolidationMgmtRoot>/<Study-name>/Logs directory to 

review the log.

If any errors are found, make necessary corrections and re-execute Setup_Dest_
CDA.sql.

2.2.5 Creating InForm Auto Merge Tables
If InForm is one of the source systems, connect to the InForm Consolidation database 
and execute the cda_cdb_automerge_ddl.sql script located in the OCDA_
HOME/oracle.pharma.ocda.standard/DataModels/ directory.

2.2.6 Creating OCDA_INFORM_VIEWs
After you have initiated at least one consolidation and created Auto Merge tables, 
perform the following steps before running ETL against the consolidation schema:

1. Connect to the Consolidation schema database as SYSTEM.

2. Execute script OCDA_INFORM_VIEWS.sql located in the OCDA_
HOME/oracle.pharma.ocda.standard/DataModels/ directory.

2.2.7 Adjusting Scheduling of Consolidation Jobs
As mentioned earlier, initial consolidations, especially of large source schemas, should 
be done in isolation to avoid contention for resources. But once the initial 
consolidation of a schema is done, subsequent consolidations of that schema are 
incremental and involve smaller numbers of records (incremental consolidations are 
limited to new or modified Subjects, CRFs, and Queries accumulated since the 
previous consolidation).

Once initial consolidation of a source schema is complete, it is useful to adjust the 
scheduling of its incremental consolidations so that they start near to the time of other 
incremental consolidation of other source schemas. The closer in time consolidations 
start across studies, the smaller the time period represented in the consolidation 
schema. 

To adjust the time when a study's consolidation job executes, perform the following 
steps:

1. Connect as the source schema owner.

2. Determine the consolidation job ID using the following query for InForm 4.6:

select job
from user_jobs
where what like 'REFRESH_PROCS.REFRESH_WITH_STREAMS_DELAY%';

or the following query for InForm 5.5, 6.0, and 6.1:

select job
from user_jobs
where what = 'CDA_PROCS.CONSOLIDATE';

3. Change the time for the next execution of the job by using the dbms_job.next_date 
procedure.
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Remember to follow the call with a commit. For example,

begin
dbms_job.next_date (
  job => 12345,
  next_date => to_date('21-AUG-2013@01:01:00','DD-MON-YYYY@HH24:MI:SS')
);
end;
commit;
/

This causes job 12345 to next be executed at 1:01 AM on 21-AUG-2013.

You can also change the interval between subsequent executions of the job using the 
dbms_job.interval procedure. Set the interval parameter to the string 'SYSDATE + 
<desired-interval>', replacing <desired-interval> with the number of days, or the 
fraction of a day to elapse before the next execution.

begin
dbms_job.interval(
  job => 12345,
  interval => 'SYSDATE + 1/2'
);
end;
commit;
/
This sets the interval between executions of job 12345 to half a day or every 12 hours.

2.3 Source-specific Procedures
This section describes procedures you must perform for certain OHSCDA sources. 
Please review each section and determine if it applies to the source(s) you are using for 
OHSCDA. If the section does apply, carry out the procedure. If the section is optional, 
decide whether it is appropriate for your requirements and act accordingly.

2.3.1 Handling Deletions of Source Records
Different source applications handle the deletion of records in different ways. Oracle 
Clinical allows deletions of records in a way that avoids orphans, and has built-in 
auditing of these deletions. Siebel Clinical also allows deletions, properly cascading to 
maintain referential integrity, but does not have built-in auditing of deletions. InForm 
does not provide any means to hard-delete records in its transactional database. So, it 
does not need to be concerned neither with maintaining integrity in the face of 
deletions nor with auditing deletions.

2.3.1.1 Handling Deletions in Oracle Clinical
OHSCDA's ETL consults the audit trails to determine if source records have been 
deleted, and then soft-deletes those records in the warehouse.

2.3.1.2 Handling Deletions in Siebel Clinical
OHSCDA defines an optional process that you can use to manage hard deletion of 
records in Siebel Clinical. You create table and triggers in the source system to handle 

Note: The next_date parameter is an Oracle date-time in which you 
can specify both the date and time for the next execution.
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deletion of records. For a description of this process, see Oracle Clinical Development 
Analytics Administrator's Guide.

2.3.1.3 Handling Deletions in InForm
Since no deletions are supported through the InForm UI, OHSCDA makes no 
provision for detecting them. If you need to delete records from an InForm 
transactional table at the backend and want the OHSCDA warehouse to be consistent 
with that change, you must identify the warehouse records that arose from the InForm 
records that are to be deleted. Also, you must remove them from the consolidation 
schema and the warehouse.

2.3.2 (Optional) Handling Deletion or Deactivation of a Study
Depending on how you use OHSCDA, you may prefer to have reports that give 
information only on currently active studies. If so, and if source studies are completed 
or possibly deleted, the recommended approach for removing such a study from 
OHSCDA is to use OHSCDA's access control capability. That is, enable Study and 
Study-site access controls, and then exclude the study and its sites from the list of 
studies (and sites) available to OHSCDA users. Aside from being simpler than 
identifying and deleting records from the warehouse, this approach has the advantage 
of being reversible if the decision to remove the study from the warehouse is 
reconsidered.

If you do not wish to use access control to avoid display of deactivated or deleted 
studies, there is an alternative solution. In the OHSCDA warehouse, every dimension 
table, and every base fact table, has a column named DELETE_FLG. OHSCDA's 
OBIEE repository is designed to treat records where DELETE_FLG equals 'Y' as if they 
were not present in the warehouse. OHSCDA's SIL also disregards records with 
DELETE_FLG = 'Y' when calculating values for aggregate tables (those with names 
ending with _A). So you can cause records to be effectively removed from the 
warehouse by setting their DELETE_FLG to 'Y'. Thus, if a study has been removed 
from a source database, you could identify all dimension and fact records for that 
study, and set their DELETE_FLG to 'Y'. This causes them to be forever invisible to 
OHSCDA's analytics.

This solution could be used, but only with great caution, for a study that is considered 
to be deactivated, but still remains in the source. Once marked as deleted, warehouse 
records for a study will not get their DELETE_FLG set back to 'N', but OHSCDA 
creates new warehouse records if there are changes or additions in the source for that 
study. So, if the study is truly inactive in the source, soft-deleting warehouse records 
for the study by setting DELETE_FLG to 'Y' will work. But any changes or additions to 
the study would cause new records to be loaded into the warehouse for the study, and 
it would re-appear in analyses.

2.3.3 (Optional) Fine-tuning of Oracle Clinical Settings
To optimize source system integration with OHSCDA, perform the following steps:

1. For OC 4.6, navigate to Informatica Relational Connections > OC Connection 
Object > Attribute in Informatica Workflow Manager.

2. Set Connection Environment SQL value as:

■ For Oracle Database 11.2.0.2:

alter session set optimizer_features_enable='11.2.0.2'

■ For Oracle Database 11.2.0.3:
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alter session set optimizer_features_enable='11.2.0.3'

■ For Oracle Database 11.1.0.7:

alter session set optimizer_features_enable='11.1.0.7'

3. Create the following indexes:

■ Function based index on DISCREPANCY_ENTRIES - NVL 
("MODIFICATION_TS", "CREATION_TS")

■ Function based index on DISCREPANCY_ENTRY_REVIEW_HIST - NVL 
("NEXT_STATUS_TS", "CREATION_TS")

■ Function based index on RECEIVED_DCIS - NVL ("MODIFICATION_TS", 
"RECEIVED_DCI_ENTRY_TS")

■ Function based index on RECEIVED_DCMS - NVL ("MODIFICATION_TS", 
"RECEIVED_DCM_ENTRY_TS") 
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3Upgrading Oracle Health Sciences Clinical 
Development Analytics

This chapter provides procedures that explain how to upgrade OHSCDA. It includes 
the following section:

■ Section 3.1, "Upgrading from OHSCDA 3.0 Standard to OHSCDA 3.2"

3.1 Upgrading from OHSCDA 3.0 Standard to OHSCDA 3.2
The Installer automates the upgrade of the warehouse and the Informatica mappings. 
After running the Installer, to complete the upgrade from OHSCDA 3.0 to OHSCDA 
3.2, perform the steps mentioned in Section 3.1.3, "Performing Next Steps" through 
Section 3.1.7, "Executing the ETL Load Plan".

3.1.1 Prerequisites
For information, see Section 1.1, "Technology Stack and System Requirements".

3.1.2 Running the Installer in Upgrade Mode
1. Run the OHSCDA Installer as described in Section 2.1.1, "Running the OHSCDA 

Installer".

3.1.3 Performing Next Steps
After running the installer, perform the following steps:

1. To enable multi-byte character support, execute the Database Migration Assistant 
for Unicode (DMU) on the CDA warehouse schema.

For information, see Oracle Database Migration Assistant for Unicode Guide.

2. Perform the steps listed in Section 3.1.4, "Migrating Data from OHSCDA 3.0 
Standard to OHSCDA 3.2".

3. Perform the steps listed in the following sections:

■  Section 2.1.4, "Emplacing the OHSCDA Help and Image Files" 

Note: OHSCDA 3.2 is certified on Oracle Database 12.1.0.2.0. For 
detailed certification information, see Finding Certification 
Information.
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■  Section 2.1.5, "Preparing the OBIEE Web Catalog and Repository for 
OHSCDA"

■ Section 2.1.6, "Configuring Maps"

■  Section 2.1.7, "Creating Security Groups and Application Roles for OHSCDA" 

3.1.4 Migrating Data from OHSCDA 3.0 Standard to OHSCDA 3.2
Perform the following steps to migrate data from OHSCDA 3.0 Standard to OHSCDA 
3.2:

1. Log on to the OHSCDA warehouse schema.

<warehouse_user>/<warehouse_password>@<SID>

2. Create the following database links:

■ sc_dblink for Siebel Clinical source

Example (SC):

create database link <sc_dblink>
connect to <sc_username>  identified by <sc_password>
using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(CONN
ECT_DATA=(SID=<sidname>)))';

■ if_dblink for InForm source

Example (IF):

create database link <if_dblink>
connect to <inform_username>  identified by <inform_password>
using 
'(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<hostname>)(PORT=<portno>))(CONN
ECT_DATA=(SID=<sidname>)))';

3. Connect to the warehouse schema.

4. Execute the following migration scripts in the sequence as mentioned:

a. drv_Migrate_CDA30_to_32_SC_Set1.sql

b. drv_Migrate_CDA30_to_32_SC_Set2.sql

c. drv_Migrate_CDA30_to_32_IF.sql

d. drv_Migrate_CDA30_to_32_Cleanup.sql

5. Execute the following command:

Note: If you are upgrading from OHSCDA 3.0 and have modified 
the OBIEE repository or Web Catalog, merge these objects. For more 
information, refer to Oracle® Fusion Middleware Metadata Repository 
Builder's Guide for Oracle Business Intelligence Enterprise Edition 11g.

Note: Data migration scripts are available in OCDA_
HOME\oracle.pharma.ocda\OCDA_
Standard\DataModels\Migration_Scripts3.0_to_3.2.zip.
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update  W_RXI_RACT_CATEGORY_D set SBR_FLG='N' where row_wid=-1;
commit;

3.1.5 Importing the OHSCDA Warehouse Application Metadata into the DAC Repository
1. Unzip <ocda_home>\ oracle.pharma.ocda.standard\DAC_Code\CDA_

Warehouse.zip into a local folder.

2. Start the Data Warehouse Administration Console (DAC) client.

3. From the Tools menu, select DAC Repository Management, and then select 
Import.

4. Click Change import/export folder to navigate to the folder where you unzipped 
CDA_Warehouse.zip.

5. Click OK to display the Import dialog box.

6. Select the following categories of metadata you want to import: Update existing 
records, Logical, Overwrite log file, and User Data.

7. Deselect the System check box.

8. Click OK.

9. Enter the verification code and OK in the secondary window that is displayed 
after the import. 

10. Select one of the following execution plan and click Build.

■ CDA - Complete Warehouse

■ CDA - Siebel Clinical Warehouse

■ CDA - Oracle Clinical Warehouse

■ CDA - InForm Warehouse

11. Execute the execution plan which you built in the earlier step.

3.1.6 Merging Changes into a New Oracle-supplied Repository
Each OHSCDA release, and some patches, includes a copy of the OHSCDA 
Repository. If you do modify your copy of the OHSCDA Repository, you must merge 
your changes into the Oracle-supplied Repository each time you receive a release or 
patch of OHSCDA that includes a repository. At upgrade time, use the OBIEE Merge 
Repository Wizard (accessed through File > Merge) in the Repository Administration 
Tool to merge your modified RPD with the Oracle-supplied RPD.

For information on comparing and merging Repositories, refer to Oracle Fusion 
Middleware Metadata Repository Builder's Guide for Oracle Business Intelligence Enterprise 
Edition 11g.

Note: Complete warehouse has InForm source extractions ETL 
added.

Note: The execution plan must be same as the what you had 
executed in OHSCDA 3.0.
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3.1.7 Executing the ETL Load Plan
For information, see Oracle Health Sciences Clinical Development Analytics Administrator’s 
Guide.
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